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Question Number : 1 Question Id : 2549896430 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT an example of an application software?

Options :

1.  MS-Word

2.  Screen saver program

3.  Operating system

4.  Antivirus program

   

Question Number : 1 Question Id : 2549896430 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा एप्लीकेशन सॉफ्टवेयर का एक उदाहरण नहीं है?

Options :

1.  MS-Word

2.  स्क्रीन सेवर प्रोग्राम



3.  ऑपरेिटंग िसस्टम

4.  एटंीवायरस प्रोग्राम

   

Question Number : 2 Question Id : 2549896447 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

If a computer is switched on but does NOT respond to a system reset, what is it said to be?

Options :

1.  Dead

2.  Off

3.  Hang

4.  Insensitive

   

Question Number : 2 Question Id : 2549896447 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

यिद कोई कंप्यूटर ऑन है लेिकन िसस्टम िरसेट पर कोई प्रितिक्रया नहीं दे रहा है, तो यह िकस िस्थित में है?

Options :

1.  डेड

2.  ऑफ

3.  हैंग

4.  इंसेंिसिटव

   

Question Number : 3 Question Id : 2549897551 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is meant by a compiler?

Options :

1.  It translates source code to object code.

2.  It is a low level language.

3.  It is an assembly language.

4.  It translates object code to assembly language.

   

Question Number : 3 Question Id : 2549897551 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कंपाइलर क्या करता है?

Options :

1.  यह सोसर् कोड को ऑब्जेक्ट कोड में अनूिदत करता है।

2.  यह एक िनम्न स्तरीय भाषा है।

3.  यह एक असेंबली भाषा है।

4.  यह ऑब्जेक्ट कोड को असेंबली भाषा में अनूिदत करता है।

   

Question Number : 4 Question Id : 2549898418 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Excel में, कौन सा फंक्शन सबसे छोटा मान देता है िजसके िलए संचयी िद्वपद िवतरण एक मापदंड मान से कम या बराबर है?

Options :



1.  BINOMINV फंक्शन

2.  BINOM.INV फंक्शन

3.  INVBINOM फंक्शन

4.  INV.BINOM फंक्शन

   

Question Number : 4 Question Id : 2549898418 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which function returns the smallest value for which the cumulative binomial distribution is greater 

than or equal to a criterion value in Excel?

Options :

1.  BINOMINV function

2.  BINOM.INV function

3.  INVBINOM function

4.  INV.BINOM function

   

Question Number : 5 Question Id : 2549899320 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Keyboard keys like Caps Lock that turn a feature on or off are called:

Options :

1.  combination keys

2.  toggle keys

3.  function keys



4.  special purpose keys

   

Question Number : 5 Question Id : 2549899320 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िकसी फ़ीचर को चालू या बंद करने वाली Caps Lock जैसी की-बोडर् कीज़ क्या कहलाती हैं?

Options :

1.  कॉिम्बनेशन कीज़

2.  टॉगल कीज़

3.  फंक्शन कीज़

4.  स्पेशल पपर्ज़ कीज़

   

Question Number : 6 Question Id : 25498912044 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The function of an assembler is to convert:

Options :

1.  basic language into machine language

2.  high level language into machine language

3.  assembly language into machine language

4.  assembly language into high level language

   

Question Number : 6 Question Id : 25498912044 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

असेंबलर का काम ______ पिरवितंत करना है।

Options :

1.  बेिसक भाषा को मशीनी भाषा में

2.  उच्च स्तरीय भाषा को मशीनी भाषा में

3.  असेंबली भाषा को मशीनी भाषा में

4.  असेंबली भाषा को उच्च स्तरीय भाषा में

   

Question Number : 7 Question Id : 25498920674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is a Jacquard loom?

Options :

1.  A bird found in Japan

2.  A weaving machine using punched cards

3.  The first computer controlled loom

4.  A machine for writing math tables

   

Question Number : 7 Question Id : 25498920674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जैकवडर् लूम (Jacquard Loom) से क्या आशय है?

Options :

1.  जापान में पाया जाने वाला एक पक्षी

2. 



 एक बुनाई मशीन िजसमें पंच काडर् का इस्तमेाल िकया जाता था

3.  कंप्यूटर द्वारा िनयंित्रत पहला लूम

4.  पहाडे़ िलखने वाली एक मशीन

   

Question Number : 8 Question Id : 25498929735 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ को, िवद्युत रूप से प्रोग्राम िकया जाता है और िमटाया जाता है। इसे लगभग दस हज़ार बार िमटाया और प्रोग्राम िकया जा 

सकता है।

Options :

1.  मास्क्ड ROM

2.  PROM

3.  EPROM

4.  EEPROM

   

Question Number : 8 Question Id : 25498929735 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The ______ is programmed and erased electrically. It can be erased and reprogrammed about ten 

thousand times.

Options :

1.  masked ROM

2.  PROM

3.  EPROM

4. 



 EEPROM

   

Question Number : 9 Question Id : 25498929896 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न में से कौन सा एक ऐसा बारकोड फ़ॉन्ट है िजसमें बड़ी मात्रा में टेक्स्ट और डेटा को संपीिडत रूप में संग्रिहत िकया जाता है, 

िजसका उपयोग एयरलाइन के बोिडंग पास में भी िकया जाता है?

Options :

1.  PDF417

2.  मैक्सीकोड

3.  डेटा मिैट्रक्स

4.  कोडबार (Codabar)

   

Question Number : 9 Question Id : 25498929896 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following barcode fonts stores large amounts of text and data in a compressed form 

that is also used by airlines on boarding passes?

Options :

1.  PDF417

2.  MaxiCode

3.  Data Matrix

4.  Codabar

   

Question Number : 10 Question Id : 25498929978 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is a video conferencing software?

Options :

1.  Google Meet

2.  Google Docs

3.  Google Map

4.  Google Pay

   

Question Number : 10 Question Id : 25498929978 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा एक वीिडयो कॉन्फ्रें िसंग सॉफ्टवेयर है?

Options :

1.  Goggle Meet

2.  Google Docs

3.  Google Map

4.  Google Pay

   

Question Number : 11 Question Id : 25498931270 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

मदरबोडर् पर ऐक्सीलेरेटेड ग्रािफक्स पोटर् (AGP) एक्सपेंसन स्लॉट ______ बस पर चलता है।

Options :



1.  16-िबट

2.  32-िबट

3.  64-िबट

4.  128-िबट

   

Question Number : 11 Question Id : 25498931270 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Accelerated Graphics Port (AGP) expansion slot on the motherboard runs on a ______ bus.

Options :

1.  16-bit

2.  32-bit

3.  64-bit

4.  128-bit

   

Question Number : 12 Question Id : 25498931334 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What is the Hexadecimal equivalent of (100)10?

Options :

1.  160

2.  256

3.  64

4.  16



   

Question Number : 12 Question Id : 25498931334 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

(100)10 का हेक्साडेिसमल समतुल्य क्या है?

Options :

1.  160

2.  256

3.  64

4.  16

   

Question Number : 13 Question Id : 25498933058 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following keyboards is designed in the likeness of old-fashioned type writer?

Options :

1.  Qwerty keyboards 

2.  Numeric keypads   

3.  Ergonomic keyboards

4.  Magic keyboards

   

Question Number : 13 Question Id : 25498933058 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा कीबोडर् पुराने जमाने के टाइप राइटर की तरह बनाया गया है?



Options :

1.  क्वेटीर् कीबोडर्

2.  न्यूमेिरक कीपैड

3.  एगोर्नोिमक कीबोडर्

4.  मैिजक कीबोडर्

   

Question Number : 14 Question Id : 25498933186 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In the ______, seven digit binary numbers (between 0 to 127) are used to represent specific 

characters.

Options :

1.  ASCII character set

2.  Binary Coded Decimal

3.  Gray Code

4.  Decimal Code

   

Question Number : 14 Question Id : 25498933186 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

________ में, िविशष्ट वणोर्ं को दशार्ने के िलए सात अंकों की बाइनरी संख्या (0 से 127 के बीच) का उपयोग िकया जाता है।

Options :

1.  ASCII कैरेक्टर सेट

2.  बाइनरी कोडेड डेसीमल



3.  ग्रे कोड

4.  डेसीमल कोड

   

Question Number : 15 Question Id : 25498933944 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ allows screen positions to be selected with the touch of a finger.

Options :

1.  Touch panel

2.  Keyboard

3.  Light Pen

4.  Mouse

   

Question Number : 15 Question Id : 25498933944 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ एक उंगली से टच करके स्क्रीन पोजीशन चुनने की सुिवधा देता है।

Options :

1.  टच पैनल

2.  कीबोडर्

3.  लाइट पेन

4.  माउस

   

Question Number : 16 Question Id : 2549898791 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a component of LAN?

Options :

1.  Tube

2.  NIC

3.  Switch

4.  UTP

   

Question Number : 16 Question Id : 2549898791 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न में से कौन सा LAN का एक घटक नहीं है?

Options :

1.  ट्यूब

2.  NIC

3.  िस्वच

4.  UTP

   

Question Number : 17 Question Id : 2549899478 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a characteristic of impact printers?

Options :



1.  Very noisy

2.  Very high consumable costs

3.  Useful for bulk printing due to low cost

4.  There is physical contact with the paper to produce an image

   

Question Number : 17 Question Id : 2549899478 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न में से क्या इम्पकै्ट िप्रंटरों की एक िवशेषता नहीं है?

Options :

1.  ये बहुत शोर करते हैं

2.  इनकी उपभोग्य लागत बहुत अिधक होती है

3.  इनके द्वारा िप्रंिटगं की लागत बहुत कम आती है इसिलए अिधक संख्या में िप्रिंटगं के िलए इनका उपयोग िकया जाता है

4.  इनके द्वारा छपाई के िलए पेपर को हाथ से पकड़ना पड़ता है

   

Question Number : 18 Question Id : 2549899492 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

If you want to set the number of copies to be printed in MS-Word, then which of the following is 

the correct option?

Options :

1.  File->Print->in 'copies' option, enter number of copies

2.  File->Print->Properties->Quality->select number of copies option, enter number of copies

3.  File->Print->Properties->Page setup->select number of copies option, enter number of copies



4.  File->Print->Properties->Page setup->select output size option

   

Question Number : 18 Question Id : 2549899492 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word में, यिद आप िप्रंट करने के िलए प्रितयों की संख्या सेट करना चाहते हैं, तो उसके क्रमों से संबंिधत सही िवकल्प कौन सा 

है?

Options :

1.  फाइल -> िप्रंट -> 'कॉपीज़' िवकल्प में प्रितयों की संख्या प्रिवष्ट करें

2.  फाइल -> िप्रंट -> प्रॉपटीर्ज -> क्वािलटी -> 'प्रितयों की संख्या' िवकल्प को चनुें, प्रितयों की संख्या प्रिवष्ट करें

3.  फाइल -> िप्रंट -> प्रॉपटीर्ज -> पेज सेटअप -> 'प्रितयों की संख्या िवकल्प' चुनें, प्रितयों की संख्या प्रिवष्ट करें

4.  फाइल -> िप्रंट -> प्रॉपटीर्ज -> पेज सेटअप -> 'आउटपुट साइज़' िवकल्प चुनें

   

Question Number : 19 Question Id : 2549899599 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

With reference to printers, PJL stands for:

Options :

1.  Portable Job Language

2.  Portable Job Library

3.  Printer Job Library

4.  Printer Job Language

   

Question Number : 19 Question Id : 2549899599 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 



: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िप्रंटरों के संदभर् में PJL का पूणर्रूप क्या है?

Options :

1.  Portable Job Language (पोटेर्बल जॉब लैंग्वेज)

2.  Portable Job Library (पोटेर्बल जॉब लाइब्रेरी)

3.  Printer Job Library (िप्रंटर जॉब लाइब्रेरी)

4.  Printer Job Language (िप्रंटर जॉब लैंग्वेज)

   

Question Number : 20 Question Id : 2549899627 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT a printer manufacturing company?

Options :

1.  Epson

2.  Canon

3.  Nippon Electric

4.  Tindle

   

Question Number : 20 Question Id : 2549899627 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सी कंपनी िप्रंटर नहीं बनाती है?

Options :

1.  एप्सन (Epson)



2.  कैनन (Canon)

3.  िनपॉन इलिेक्ट्रक (Nippon Electric)

4.  िटंडल (Tindle)

   

Question Number : 21 Question Id : 25498911108 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

वायरलेस नेटवकोर्ं के िलए IEEE मानक िनम्न में से कौन सा है?

Options :

1.  801.12

2.  801.22

3.  802.11

4.  802.13

   

Question Number : 21 Question Id : 25498911108 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is the IEEE standard for wireless networks?

Options :

1.  801.12

2.  801.22

3.  802.11

4.  802.13

   



Question Number : 22 Question Id : 25498911261 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Gateway works at which of the layers of the OSI model?

Options :

1.  Physical layer

2.  Session layer

3.  Network layer

4.  Data link layer

   

Question Number : 22 Question Id : 25498911261 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

OSI मॉडल के कौन-से स्तर (लेयर) पर गेटवे (Gateway) काम करता है?

Options :

1.  िफिज़कल लेयर

2.  सेशन लेयर 

3.  नेटवकर्  लेयर 

4.  डेटा िलंक लेयर 

   

Question Number : 23 Question Id : 25498911272 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The major advantage of FM over AM is:



Options :

1.  higher geographical interference

2.  high radiated power

3.  more complicated receiver and transmitter

4.  improved signal to noise ratio

   

Question Number : 23 Question Id : 25498911272 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

AM की तुलना में FM का मुख्य लाभ क्या है?

Options :

1.  उच्च भौगोिलक हस्तक्षेप

2.  उच्च िविकरण शिक्त

3.  अिधक जिटल िरसीवर और ट्रांसमीटर

4.  शोर अनुपात के िलए बेहतर संकेत

   

Question Number : 24 Question Id : 25498913470 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following features allow you to narrow down the data in your work sheet?

Options :

1.  Filters

2.  Merge Cells

3.  Fill Handle



4.  Format

   

Question Number : 24 Question Id : 25498913470 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सी िवशेषताए ंआपको अपनी वकर् शीट में डेटा को कम करने की अनुमित देती हैं?

Options :

1.  िफल्टर 

2.  मजर् सेल

3.  िफल हैंडल

4.  फॉमेर्ट

   

Question Number : 25 Question Id : 25498913778 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ creates a unique, fixed-length signature for a message or data set.

Options :

1.  Popular key algorithm

2.  Secret key algorithm

3.  Public key algorithm

4.  Hashing

   

Question Number : 25 Question Id : 25498913778 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

________ िकसी मैसेज या डेटा सेट के िलए एक अनूठा, िनिश्चत लंबाई वाला हस्ताक्षर िक्रएट करता है।

Options :

1.  पॉपुलर की एल्गोिरथम

2.  सीके्रट की एल्गोिरथम

3.  पिब्लक की एल्गोिरथम

4.  हैिशंग

   

Question Number : 26 Question Id : 25498918499 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The dot matrix printer belongs to which of the following categories of printers?

Options :

1.  Line

2.  Off band

3.  Non-impact

4.  Character

   

Question Number : 26 Question Id : 25498918499 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

डॉट मिैट्रक्स िप्रंटर िनम्न में से िकस प्रकार का िप्रंटर है?

Options :

1.  लाइन

2. 



 ऑफ बैंड

3.  नॉन-इम्पकै्ट

4.  कैरेक्टर

   

Question Number : 27 Question Id : 25498918527 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

There are operating systems that perform multitasking. Which of the following is NOT a 

multitasking enabled OS?

Options :

1.  Windows 10

2.  Windows XP

3.  Windows 7

4.  MS DOS 2.0

   

Question Number : 27 Question Id : 25498918527 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कई ऑपरेिटगं िसस्टम मल्टीटािस्कंग (एकािधक कायर्) करते हैं। िनम्न में से कौन सा मल्टीटािस्कंग ऑपरेिटगं िसस्टम (OS) नहीं है?

Options :

1.  Windows 10

2.  Windows XP

3.  Windows 7

4.  MS DOS 2.0



   

Question Number : 28 Question Id : 25498924004 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In Graphical User Interface ( GUI ) computer, the __________  is an image that represents an 

application, a capability, or some other concept or specific entity with meaning for the user.

Options :

1.  label

2.  icon

3.  graph

4.  file

   

Question Number : 28 Question Id : 25498924004 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ग्रािफकल यूजर इंटरफेस (GUI) कंप्यटूर में, __________ एक इमेज है जो एक एिप्लकेशन, एक क्षमता, या कुछ अन्य अवधारणा या 

िविशष्ट इकाई का प्रितिनिधत्व करती है जो उपयोगकतार् के िलए मायने रखती है।

Options :

1.  लेबल

2.  आइकन

3.  ग्राफ

4.  फाइल

   

Question Number : 29 Question Id : 25498924033 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

The ______ is the bar that runs across the bottom of the Windows screen in a computer system.

Options :

1.  Title bar

2.  Taskbar

3.  Toolbar

4.  Menu bar

   

Question Number : 29 Question Id : 25498924033 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

______ वह बार है जो कंप्यटूर िसस्टम में Windows स्क्रीन के नीचे चलता है।

Options :

1.  टाइटल बार

2.  टास्कबार

3.  टूलबार

4.  मेनू बार

   

Question Number : 30 Question Id : 25498924297 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

A program which is input to the compiler is called a ______.

Options :

1.  Source program

2. 



 Object code

3.  Translator

4.  Enabler

   

Question Number : 30 Question Id : 25498924297 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

एक प्रोग्राम जो कंपाइलर के िलए इनपुट होता है, उसे ______ कहा जाता है।

Options :

1.  सोसर् प्रोग्राम

2.  ऑब्जेक्ट कोड

3.  ट्रांसलेटर

4.  इनेबलर

   

Question Number : 31 Question Id : 2549896773 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT an email program?

Options :

1.  Microsoft Outlook Express

2.  Gmail

3.  eBay

4.  Thunderbird

   



Question Number : 31 Question Id : 2549896773 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा एक ईमेल प्रोग्राम नहीं है?

Options :

1.  Microsoft Outlook Express

2.  Gmail

3.  eBay

4.  Thunderbird 

   

Question Number : 32 Question Id : 2549897211 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

गूगल कैलेंडर में इवेंट िववरण देखने के िलए ______ की का उपयोग िकया जाता है।

Options :

1.  N

2.  S

3.  T

4.  E

   

Question Number : 32 Question Id : 2549897211 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In Google calendar, ______ key is used to view an event's details.

Options :



1.  N

2.  S

3.  T

4.  E

   

Question Number : 33 Question Id : 2549897935 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which among the following is NOT a secondary storage device in a computer?

Options :

1.  RAM

2.  Hard Disk

3.  CD

4.  DVD

   

Question Number : 33 Question Id : 2549897935 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौनसा कंप्यटूर में सेकें डरी स्टोरेज िडवाइस नहीं है?

Options :

1.  RAM

2.  हाडर् िडस्क

3.  CD

4.  DVD



   

Question Number : 34 Question Id : 2549898979 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word tables, the AutoFit button is used to:

Options :

1.  format each columns width to be as bold as the size of the text

2.  format each columns width to be only as wide as the text in the longest cell in the column

3.  cut the text and paste in a new location

4.  make large documents more readable

   

Question Number : 34 Question Id : 2549898979 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word टेबल में, AutoFit बटन का उपयोग िनम्न के िलए िकया जाता है:

Options :

1.  प्रत्येक कॉलम की चौड़ाई को टेक्स्ट के आकार िजतना बोल्ड होने के िलए प्रारूिपत करें

2.  कॉलम में सबसे लंबे सेल में टेक्स्ट के रूप में केवल उतना ही चौड़ा होने के िलए प्रत्येक कॉलम की चौड़ाई को प्रारूिपत करें

3.  टेक्स्ट को कट करने और नए स्थान पर पेस्ट करने

4.  बडे़ डॉक्यूमेंट को और अिधक पठनीय बनाने

   

Question Number : 35 Question Id : 25498910503 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



When we apply any change case to an alphanumeric term, which of the following options will be 

true in MS-Word?

Options :

1.  It converts only the letters in the alphanumeric.

2.  It converts only the letters and deletes the numbers.

3.  No action will be performed.

4.  It always converts the text into small letters.

   

Question Number : 35 Question Id : 25498910503 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जब हम अल्फ़ान्यूमेिरक शब्द में कोई पिरवतर्न मामला लागू करते हैं, तो MS-Word में िनम्निलिखत में से कौन सा िवकल्प सही होगा?

Options :

1.  यह केवल अक्षरों को अल्फ़ान्यूमेिरक में पिरवितंत करता है।

2.  यह केवल अक्षरों को पिरवितंत करता है और सखं्याओं को हटा देता है।

3.  कोई कारर्वाई नहीं की जाएगी।

4.  यह हमेशा टेक्स्ट को छोटे अक्षरों में बदलता है।

   

Question Number : 36 Question Id : 25498910553 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word, if you choose 'Mirror margins' from the standard margin styles, then the labels, Left 

and Right margins change to ______.

Options :

1.  Top and Bottom



2.  Left and Right

3.  Inside and Outside

4.  Bottom and Top

   

Question Number : 36 Question Id : 25498910553 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word में, यिद आप मानक मािजंन शैिलयों से 'िमरर मािजंन' चुनते हैं, तो लेबल, बाए ँऔर दाए ँमािजंन ______ में बदल जाते हैं।

Options :

1.  टॉप और बॉटम

2.  लेफ्ट और राइट

3.  इनसाइड और आउटसाइड

4.  बॉटम और टॉप

   

Question Number : 37 Question Id : 25498910577 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

If Deepika wants to hide the ruler, then she has to choose 'View' and select the _______ check box in 

MS-Word.

Options :

1.  Ruler

2.  Grid lines

3.  Message bar

4.  Thumbnails



   

Question Number : 37 Question Id : 25498910577 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

यिद दीिपका रूलर को छुपाना चाहती है, तो उसे 'व्यू' चुनना होगा और MS-Word में _______ चेक बॉक्स का चयन करना होगा।

Options :

1.  रूलर

2.  िग्रड लाइनें

3.  संदेश बार

4.  थंबनेल

   

Question Number : 38 Question Id : 25498910600 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

From the following options, identify the special types of indentation in MS-Word. 

a) First line 

b) Hanging 

c) Left indent 

d) Right indent

Options :

1.  a, b

2.  b, c

3.  b, d

4.  a, c

   



Question Number : 38 Question Id : 25498910600 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत िवकल्पों में से MS-Word में िवशेष प्रकार के इंडेंटेशन की पहचान करें। 

 

a) पहली लाइन 

b) हैंिगंग 

c) बायां इडंेंट 

d) दायां इंडेंट

Options :

1.  a, b

2.  b, c

3.  b, d

4.  a, c

   

Question Number : 39 Question Id : 25498910722 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following option is invalid during document search in MS-Word?

Options :

1.  Match case

2.  No formatting

3.  Find whole words only

4.  Sounds like

   

Question Number : 39 Question Id : 25498910722 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में MS-Word में दस्तावेज़ खोज के दौरान कौन सा िवकल्प अमान्य है?

Options :

1.  मैच केस

2.  नो फोमेर्िटंग

3.  फाइंड होल वड्र्स ओनली

4.  साउंड लाइक

   

Question Number : 40 Question Id : 25498911504 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Following are the steps to turn off the Capitalize the first letter of sentences feature in MS-Word. 

Arrange the steps in the correct order. 

 

a) Make sure the AutoCorrect tab is displayed. 

b) Choose AutoCorrect Options from the Tools menu. Word displays the AutoCorrect dialog box. 

c) Click on OK. 

d) Clear the Capitalize First Letter of Sentences check box.

Options :

1.  b, a, d, c

2.  b, a, c, d

3.  b, d, a, c

4.  b, c, d, a

   

Question Number : 40 Question Id : 25498911504 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

MS-Word में कैिपटलाइज द फस्टर् लेटर ऑफ सेंटेंस फीचर को बंद करने के चरण िनम्निलिखत हैं। चरणों को सही क्रम में व्यविस्थत 

करें। 

 

a) सुिनिश्चत करें िक ऑटोकरेक्ट टैब िदख रहा है। 

b) टूल्स मेनू से ऑटोकरेक्ट िवकल्प चुनें। Word ऑटोकरेक्ट डायलॉग बॉक्स प्रदिशंत करता ह ै

c) OK पर िक्लक करें। 

d) 'Capitalize First Letter of Sentences' चेक बॉक्स को िक्लयर करें।

Options :

1.  b, a, d, c

2.  b, a, c, d

3.  b, d, a, c

4.  b, c, d, a

   

Question Number : 41 Question Id : 25498911881 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word, ______ feature has to be selected under the Balloons command to show deletions as 

crossed out and comments inline.

Options :

1.  All Revisions Inline

2.  Show All Revisions Inline

3.  Show Revisions in balloons

4.  Show only comments and formatting in balloons
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: N.A Think Time : N.A Minimum Instruction Time : 0
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MS-Word में, हटाए गए को क्रॉस आउट और िटप्पिणयों को इनलाइन िदखाने के िलए बलून्स कमांड के तहत ______ सिुवधा का 

चयन कीिजये।

Options :

1.  सभी िरवीज़न इनलाइन

2.  सभी िरवीज़न इनलाइन िदखाए ं

3.  िरवीज़नों को बैलून्स में िदखाए ं

4.  बैलून्स में केवल कमेंट्स और फॉमेर्िटंग िदखाए ं
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Which of the following is a character encoding standard?

Options :

1.  ASCII

2.  ISO

3.  HTM

4.  XML

   

Question Number : 42 Question Id : 25498911955 Question Type : MCQ Option Shuffling : Yes 
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िनम्निलिखत में से कौन सा एक वणर् एन्कोिडंग मानक है?

Options :

1.  ASCII

2.  ISO

3.  HTM

4.  XML

   

Question Number : 43 Question Id : 25498912491 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What happens to the screen when we open a header section in MS-Word?

Options :

1.  Document area appears shaded; header marker and dashed line show up.

2.  Screen will remain unchanged.

3.  Header area brightens up.

4.  Footer section collapses

   

Question Number : 43 Question Id : 25498912491 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जब हम MS-Word में हेडर सेक्शन खोलते हैं तो स्क्रीन का क्या होता है?

Options :

1.  डॉक्यूमेंट एिरया धुंधला िदखाई देता है, हेडर माकर् र और डैश लाइन उभरकर िदखाई देती हैं।

2.  स्क्रीन अपिरवितंत रहेगी।



3.  हेडर एिरया चमकदार हो जाता है।

4.  फुटर सेक्शन गायब हो जाता है।

   

Question Number : 44 Question Id : 25498919196 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word, to start from ready to use mail merge template that can be customised according to 

the needs, __________ radio button has to be enabled under the Select starting document step. 

Options :

1.  Use the current document

2.  Start from a template

3.  Start from existing template

4.  Start using current document

   

Question Number : 44 Question Id : 25498919196 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0
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MS-Word में, रेडी टू यूज मेल मजर् टेम्प्लटे से शुरू करने के िलए िजसे जरूरतों के अनुसार अनुकूिलत िकया जा सकता है, 

__________ रेिडयो बटन को सेलेक्ट स्टािटंग डॉक्यूमेंट स्टेप के तहत सक्षम करना होगा।

Options :

1.  वतर्मान डॉक्यूमेंट का इस्तमेाल करें

2.  िकसी टेम्पलेट से शरुू करें

3.  मौजूदा टेम्पलेट से शरुू करें

4.  वतर्मान डॉक्यूमेंट के उपयोग से शुरू करें



   

Question Number : 45 Question Id : 25498920453 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

WWW uses ______ protocol.

Options :

1.  FTP

2.  HTTP

3.  WBC

4.  MTP
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Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

WWW ______ प्रोटोकॉल का उपयोग करता है।

Options :

1.  FTP

2.  HTTP

3.  WBC

4.  MTP
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_______ में, वेब पर कोई उपयोगकतार् लॉग इन करने वाले िकसी अन्य उपयोगकतार् से संपकर्  कर सकता है और बातचीत जारी रख 

सकता है।

Options :

1.  हाइपर टिमंनल सिवंस

2.  नेट कनेक्ट सिवंस

3.  इंस्टेंट सिवंस

4.  इंस्टेंट मैसिेजंग

   

Question Number : 46 Question Id : 25498923777 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In _______, a user on the Web can contact another user who is logged in and continue with the 

conversation.

Options :

1.  hyper terminal services

2.  net connect services

3.  instant services

4.  instant messaging

   

Question Number : 47 Question Id : 25498925308 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following is NOT the Section Break Option in MS-Word?

Options :

1.  Previous Page



2.  Next Page

3.  Odd Page

4.  Even Page

   

Question Number : 47 Question Id : 25498925308 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत में से कौन सा MS-Word में सेक्शन ब्रेक िवकल्प नहीं है?

Options :

1.  प्रीिवयस पेज

2.  नेक्स्ट पेज

3.  ऑड पेज

4.  इवन पेज

   

Question Number : 48 Question Id : 25498925342 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word, the page orientation will NOT affect font style, font colour, and ______.

Options :

1.  page spacing

2.  height and width

3.  font size

4.  number of lines in a page
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MS-Word में पेज ओिरएटेंशन फ़ॉन्ट के स्टाइल, फ़ॉन्ट के कलर और ______ को प्रभािवत नहीं करेगा।

Options :

1.  पेज स्पेिसंग

2.  ऊंचाई तथा चौड़ाई

3.   फ़ॉन्ट के आकार

4.  पेज में लाइनों की संख्या

   

Question Number : 49 Question Id : 25498925491 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

How will you save the existing document file in another folder in MS-Word?

Options :

1.  File->Save

2.  Ctrl + S ->Select Folder

3.  File->Save As

4.  Insert ->Save As

   

Question Number : 49 Question Id : 25498925491 Question Type : MCQ Option Shuffling : Yes 
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: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

आप MS-Word में मौजूदा दस्तावेज़ फ़ाइल को दूसरे फ़ोल्डर में कैसे सहजेेंगे?



Options :

1.  File->Save

2.  Ctrl + S ->Select Folder

3.  File->Save As

4.  Insert ->Save As

   

Question Number : 50 Question Id : 25498925509 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Which of the following font effects places text below other characters on the same line in MS-

Word?

Options :

1.  Subscript

2.  Strikethrough

3.  Emboss

4.  Superscript
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िनम्निलिखत में से कौन सा फॉन्ट प्रभाव MS-Word में टेक्स्ट को अन्य वणोर्ं के नीचे एक ही पिंक्त में रखता है?

Options :

1.  सबिस्क्रप्ट

2.  स्ट्राइकथ्रू

3. 



 एमबॉस

4.  सुपरिस्क्रप्ट

   

Question Number : 51 Question Id : 25498930511 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

In MS-Word, some dialog boxes have multiple tabs. You can switch between these tabs by 

pressing the ______ keys together.

Options :

1.  Ctrl + Z

2.  Ctrl + Tab

3.  Alt + Tab

4.  Alt + N
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एमएस-वडर् में, कुछ डायलॉग बॉक्स में कई टैब होते हैं। आप ______ कंुिजयों को एक साथ दबाकर इन टैब के बीच िस्वच कर सकते हैं।

Options :

1.  Ctrl + Z

2.  Ctrl + Tab

3.  Alt + Tab

4.  Alt + N

   

Question Number : 52 Question Id : 25498933769 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

While working with MS-Word, ______ option is not available in the file menu.

Options :

1.  Print

2.  Header & Footer

3.  Save As

4.  Save
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MS-Word के साथ कायर् करते समय, फाइल मने्यू में ______ िवकल्प उपलब्ध नहीं होता है।

Options :

1.  िप्रटं

2.  हैडर और फुटर

3.  सेव ऐज

4.  सेव
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Question Id : 25498921205 Question Type : COMPREHENSION Sub Question Shuffling Allowed 

: Yes Group Comprehension Questions : No Question Pattern Type : NonMatrix Calculator : 

None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Question Numbers : (53 to 57)

Read the given passage and answer the questions. 

 

My brother was five years elder to me but only three grades ahead. He’d begun his studies at the 

same age as I had, but he didn’t like the idea of moving hastily in an important matter like 

education. He wanted to lay a firm foundation so he took two years to do one year’s work. I was 

nine, he was fourteen. He had full right to supervise and instruct me. And I was expected to accept 

every order of his as law. 

 

By nature he was studious. He was always sitting with a book open. And perhaps to rest his brain, 

he would sometimes draw pictures of birds and cats in the margin of his notebook. Occasionally, 

he would write a name, a word or a sentence ten or twenty times. He might even create new 

words which made no rhyme or reason. To understand his creation was beyond my powers. 

 

I wasn’t very keen about studies. To sit with a book for an hour was a tremendous effort. As soon 

as I found a chance I’d leave the hostel and play marbles or fly paper kites or sometimes just meet 

a friend. Sometimes we would climb on to the courtyard walls and jump down. But as soon as I 



came back into the room and saw my brother’s scowling face I lost all my power to think. His first 

question would be, “Where were you?” My silence was an acknowledgement of guilt and my 

brother’s only remedy was to greet me with indignant words. 

 

“If you study English this way you’ll be studying your whole life! Studying English is no laughing 

matter, that anyone who wants to, can learn. Haven’t you seen how much I grind? Everyday there 

are cricket and hockey matches but I don’t go near them. I keep on studying all the time and even 

then it takes me two-three years for one grade. So how do you expect to pass? It would be better 

that you went home and played gilli-danda to your heart’s content. Why waste our father’s hard 

earned money?”

Sub questions

 

Question Number : 53 Question Id : 25498921206 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The author had to follow every order by his brother mainly because the brother:

Options :

1.  was wiser than him

2.  was senior to him in age

3.  was more knowledgeable

4.  had a firm foundation

 

Question Number : 54 Question Id : 25498921207 Question Type : MCQ Option Shuffling : Yes 
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Which of the following shows that the author’s brother was actually NOT studious?

Options :

1.  He always sat with a book open.



2.  He never went to watch a match.

3.  He took two years to pass a class.

4.  He didn’t go out to play.

 

Question Number : 55 Question Id : 25498921208 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0
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How do we know that the author was good at his studies?

Options :

1.  There was less gap between the author and his brother’s grades than their ages.

2.  Both, the author and his brother had started studies at the same age.

3.  The author found it hard to sit with a book.

4.  The author loved to play marbles and fly kites.

 

Question Number : 56 Question Id : 25498921209 Question Type : MCQ Option Shuffling : Yes 
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Correct Marks : 1 Wrong Marks : 0

When the author returned from playing, his brother would do all of the following, EXCEPT:

Options :

1.  make him feel guilty

2.  scold him

3.  scowl at him

4.  make him happy

 

Question Number : 57 Question Id : 25498921210 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The author would feel guilty because:

Options :

1.  he went to play instead of studying

2.  he scored better marks than his brother

3.  he had not studied English

4.  he was wasting his father’s money

   

Question Id : 25498921205 Question Type : COMPREHENSION Sub Question Shuffling Allowed 

: Yes Group Comprehension Questions : No Question Pattern Type : NonMatrix Calculator : 

None Response Time : N.A Think Time : N.A Minimum Instruction Time : 0

Question Numbers : (53 to 57)

िदए गए गद्यांश को पढ़ें  और उसके आधार पर प्रश्नों के उत्तर दें। 

 

मेरे भाई साहब मुझसे पॉँच साल बडे़ थे, लेिकन तीन दरजे आगे। उन्होने भी उसी उम्र में पढना शरुू िकया था जब मैने शुरू िकया; लेिकन 

तालीम जैसे महत्व के मामले में वह जल्दीबाजी से काम लेना पसंद न करते थे। इस भवन िक बुिनयाद खूब मजबूत डालना चाहते थे। 

इसिलए एक साल का काम दो साल में करते थे।मैं छोटा था, वह बडे़ थे। मेरी उम्र नौ साल िक,वह चौदह साल के थे। उन्हें मेरी तम्बीह 

और िनगरानी का पूरा जन्मिसद्ध अिधकार था। और मेरी शालीनता इसी में थी िक उनके हुक्म को कानून समझूँ। 

वह स्वभाव से बडे़ अघ्ययनशील थे। हरदम िकताब खोले बैठे रहते और शायद िदमाग को आराम देने के िलए कभी कापी पर, कभी 

िकताब के हािशयों पर िचिडयों, कुत्तों, बिल्लयो की तस्वीरें बनाया करते थें। कभी-कभी एक ही नाम या शब्द या वाक्य दस-बीस बार 

िलख डालते। कभी एक शेर को बार-बार सुन्दर अक्षर से नकल करते। कभी ऐसी शब्द-रचना करते, िजसमें न कोई अथर् होता, न कोई 

सामंजस्य! उनकी इन रचनाओं को समझना मेरी समझ से परे था। 

मेरा पढ़ाई में ज्यादा मन नहीं लगता था। एक घंटा भी िकताब लेकर बैठना पहाड़ था। मौका पाते ही हॉस्टल से िनकलकर मैदान में आ 

जाता और कभी कंकिरयां उछालता, कभी कागज िक िततिलयाँ उड़ाता, और कहीं कोई साथी िमल गया तो पूछना ही क्या कभी 

चारदीवारी पर चढकर नीचे कूद रहे है, कभी फाटक पर वार, उसे आगे-पीछे चलाते हुए मोटरकार का आनंद उठा रहे है। लिेकन कमरे में 

आते ही भाई साहब का रौद्र रूप देखकर प्राण सूख जाते। उनका पहला सवाल होता-'कहां थें?' हमेशा यही सवाल, इसी घ्विन में पूछा 

जाता था और इसका जवाब मेरे पास केवल मौन था। 

‘इस तरह अंग्रेजी पढ़ोगे, तो िजन्दगी-भर पढ़ते रहोगे और एक हफर्  न आएगा। अंग्रेजी पढ़ना कोई हंसी-खेल नही है, िक जो चाहे, पढ़ ले। 

तुम िकतने घोंघा हो िक मुझे देखकर भी सबक नही लेते, मैं िकतनी मेहनत करता हूं। मैं हमेशा पढ़ता रहता हूं, उस पर भी एक-एक दरजे 



में दो-दो, तीन-तीन साल पड़ा रहता हूं िफर तुम कैसे आशा करते हो िक तुम यों खेल-कुद में वक्त गंवाकर पास हो जाओगे? अगर तुम्हे 

इस तरह उम्र गंवानी है, तो बेहतर है, घर चले जाओ और मजे से गुल्ली-डंडा खेलो। िपता की गाढ़ी कमाई के रूपये क्यों बरबाद करते 

हो?’

Sub questions

 

Question Number : 53 Question Id : 25498921206 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

लेखक अपने भाई की हर बात क्यों मानता है?

Options :

1.  क्योंिक वे उससे अिधक समझदार थे

2.  क्योंिक वे उम्र में उससे बडे़ थे

3.  क्योंिक वे उससे अिधक बुिद्धमान थे

4.  क्योंिक उनकी जानकारी बहुत गूढ़ थी

 

Question Number : 54 Question Id : 25498921207 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न में से कौन सी बात यह दशार्ती है िक लेखक के भाई वास्तव में अध्ययनशील नहीं थे?

Options :

1.  वह हमेशा पुस्तक खोलकर बैठे रहते थे

2.  वह कभी भी मैच देखने नहीं जाते थे

3.  एक ही कक्षा में उत्तीणर् होने के िलए उन्हें दो वषर् लगते

4.  वह बाहर खेलने नहीं जाते थे

 

Question Number : 55 Question Id : 25498921208 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

हमें यह कैसे पता चलता है िक लेखक की पढ़ाई में रूिच थी?

Options :

1.  उसके भाई की तुलना में लेखक की उम्र और कक्षा में कम अंतर था

2.  लेखक और उसके भाई, दोनों ने पढ़ाई की शुरुआत एक ही उम्र में की थी

3.  लेखक को पुस्तक के साथ बैठे रहना बहुत किठन प्रतीत होता था

4.  लेखक को कंचे खेलना और पतंग उड़ाना बहुत पसंद था

 

Question Number : 56 Question Id : 25498921209 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

जब लेखक खेलकर वापस आता, तो उसका भाई िनम्न में से िकसके अितिरक्त उसे और सब कहता था?

Options :

1.  उसे दोषी महसूस कराता

2.  उसे डांटता

3.  उस पर गुस्सा करता

4.  उसको खुश करने की कोिशश करता

 

Question Number : 57 Question Id : 25498921210 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

लेखक स्वयं को दोषी क्यों महसूस करता था?

Options :



1.  वह पढ़ाई करने के बजाय खेलने जाता था

2.  उसने अपने भाई से बेहतर अंक प्राप्त िकए

3.  उसने अंग्रेज़ी के पाठ की पढ़ाई नहीं की थी

4.  वह अपने िपता की मेहनत की कमाई को बबार्द कर रहा था

   

   

QUANTITATIVE APTITUDE
Section Id : 2549897136

Section Number : 3

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 6

Number of Questions to be attempted : 6

Section Marks : 6

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897177

Question Shuffling Allowed : Yes

Is Section Default? : null

   

Question Number : 58 Question Id : 25498928826 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0



Options :

1.  3

2.  4

3.  5

4.  6

   

Question Number : 58 Question Id : 25498928826 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 59 Question Id : 25498928892 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 59 Question Id : 25498928892 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 



   

Question Number : 60 Question Id : 25498929050 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

What will come in place of the question mark (?) in the given number series? 

190, 94, 46, 22, ?, 4

Options :

1.  19

2.  15

3.  10

4.  8

   

Question Number : 60 Question Id : 25498929050 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   



 

   

Question Number : 61 Question Id : 25498929099 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  0.5

2.  10

3.  37

4.  45

   

Question Number : 61 Question Id : 25498929099 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  0.5

2.  10

3.  37

4.  45

   

Question Number : 62 Question Id : 25498929379 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  570

2.  760

3.  800

4.  950

   

Question Number : 62 Question Id : 25498929379 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   

 

4.   

 

   

Question Number : 63 Question Id : 25498929664 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 



: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

As observed from the top of a lighthouse, 120 m above sea level, the angle of depression of a ship, 

sailing directly towards is, changes from 30° to 45°. The distance (in m) travelled by the ship during 

the period of observation is nearest to:

Options :

1.  86.7

2.  86.9

3.  87.8

4.  88.9

   

Question Number : 63 Question Id : 25498929664 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.  86.7

2.  86.9

3.  87.8

4.  88.9

   

   

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549897137



Section Number : 4

Section type : Online

Mandatory or Optional : Mandatory

Number of Questions : 6

Number of Questions to be attempted : 6

Section Marks : 6

Display Number Panel : Yes

Enable Mark as Answered Mark for Review and 

Clear Response :
Yes

Maximum Instruction Time : 0

Sub-Section Number : 1

Sub-Section Id : 2549897178

Question Shuffling Allowed : Yes

Is Section Default? : null

   

Question Number : 64 Question Id : 25498914081 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Unscramble the letters in the words given in options, and find the odd one out.

Options :

1.  HARCI

2.  EANOGR

3.  ABNNAA

4.  EALPP

   

Question Number : 64 Question Id : 25498914081 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0



Correct Marks : 1 Wrong Marks : 0

िवकल्पों में िदए गए अव्यविस्थत अक्षरों को व्यविस्थत कर साथर्क शब्दों का िनमार्ण करें और उनमें से असंगत शब्द का चयन करें।

Options :

1.  HARCI

2.  EANOGR

3.  ABNNAA

4.  EALPP

   

Question Number : 65 Question Id : 25498918994 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Select the pair from among the options that will fill in the two blanks, respectively, to form a true 

and sensible sentence. 

 

______ is to second as day is to _______.

Options :

1.  Watch – Friday

2.  Minute – Hour

3.  First – Hour

4.  First – Light

   

Question Number : 65 Question Id : 25498918994 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्निलिखत वाक्य को सही प्रारूप में लाने के िलए इसके िरक्त स्थानों पर क्रिमक रूप से आने वाले अक्षरों वाले िवकल्प का चयन 

कीिजए। 



 

______ का सेकंड से वही संबंध है, जो संबंध िदन  का _____ से है।

Options :

1.  घड़ी – शकु्रवार

2.  िमनट – घंटा

3.  प्रथम – घंटा

4.  प्रथम – प्रकाश

   

Question Number : 66 Question Id : 25498919674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Select the option that is related to the third number in the same way as the second number is 

related to the first number. 

 

335 : 216 : : 987 : ?

Options :

1.  867

2.  868

3.  872

4.  888

   

Question Number : 66 Question Id : 25498919674 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

उस िवकल्प का चयन कीिजए जो तीसरी संख्या से उसी प्रकार संबंिधत है िजस प्रकार दूसरी संख्या पहली सखं्या से संबंिधत है।  

 



335 : 216 :: 987 : ?

Options :

1.  867

2.  868

3.  872

4.  888

   

Question Number : 67 Question Id : 25498919723 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Between the two book-ends in your study are displayed your five favourite puzzle books. If you 

decide to arrange the five books in every possible combination and moved just one book every 

minute, then how long would it take you?

Options :

1.  1 hour

2.  2 hour

3.  3 hour

4.  4 hour

   

Question Number : 67 Question Id : 25498919723 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

आपके अध्ययन कक्ष में दो पुस्तक के बीच आपकी पांच पसंदीदा पहेली की िकताबें प्रदिशंत की जाती हैं। यिद आप हर संभािवत 

संयोजन में इन पांच पसु्तकों की पुनव्यर्विस्थत करने का िनणर्य लेते हैं और प्रत्येक िमनट में केवल एक पुस्तक को उठाते हैं, तो ऐसा 

करने में आपको कुल िकतना समय लगेगा?

Options :



1.  1 घंटा

2.  2 घंटे

3.  3 घंटे

4.  4 घंटे

   

Question Number : 68 Question Id : 25498919818 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Four words have been given, out of which three are alike in some manner and one is different. 

Select the one that is different.

Options :

1.  Lima

2.  Algiers

3.  New York

4.  Tokyo

   

Question Number : 68 Question Id : 25498919818 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िवकल्पों में चार शब्द िदए गए हैं िजनमें से तीन िकसी तरह समान हैं और उनमें से कोई एक असंगत है। उस असंगत शब्द का चयन करें।

Options :

1.  लीमा

2.  अल्जीयसर्

3.  न्यूयॉकर्



4.  टोक्यो

   

Question Number : 69 Question Id : 25498927388 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3.   



 

4.   

 

   

Question Number : 69 Question Id : 25498927388 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Options :

1.   

 

2.   

 

3. 



  

 

4.   
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Question Number : 70 Question Id : 2549899686 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The Ninth Five-Year Plan in India covered the period of:

Options :

1.  1990-1995

2.  1992-1997

3.  1997-2002

4.  1999-2003

   

Question Number : 70 Question Id : 2549899686 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

भारत में नौंवीं पंचवषीर्य योजना की अविध क्या थी?

Options :

1.  1990-1995

2.  1992-1997

3.  1997-2002

4.  1999-2003

   

Question Number : 71 Question Id : 25498912534 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : 0 Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

The breeding, rearing and transplantation of fish by artificial means is called ________________.

Options :



1.  aquaculture

2.  horticulture

3.  pisciculture

4.  viticulture

   

Question Number : 71 Question Id : 25498912534 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

कृित्रम तरीकों द्वारा मछिलयों का प्रजनन, पालन और प्रितरोपण क्या कहलाता है?

Options :

1.  एक्वाकल्चर

2.  हॉिटकंल्चर

3.  िपसीकल्चर

4.  िवटीकल्चर

   

Question Number : 72 Question Id : 25498912784 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Geoff Boycott's name is associated with which of the following games?

Options :

1.  Boxing

2.  Cricket

3.  Golf

4.  Swimming



   

Question Number : 72 Question Id : 25498912784 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

ज्योफ्री बॉयकॉट का नाम िनम्न में से िकस खेल से जडु़ा हुआ है?

Options :

1.  मुक्केबाजी

2.  िक्रकेट

3.  गोल्फ़

4.  तैराकी

   

Question Number : 73 Question Id : 25498929956 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Match the columns. 

 

Landforms Processes 

A. Kick point 1. Karst 

B. Sink hole 2. Fluvial 

C. Point bar 3. Plantation 

D. Accordant summit 4. Rejuvenation 

 

Options :

1.  A-3, B-2, C-1, D-4

2.  A-4, B-1, C-2, D-3

3.  A-3, B-1, C-2, D-4



4.  A-4, B-2, C-1, D-3

   

Question Number : 73 Question Id : 25498929956 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

िनम्न को सुमेिलत कीिजए:  

 

स्थलाकृितयां प्रिक्रयाए ं

A. िकक पॉइंट 1. कास्टर् 

B. िसंक होल 2. फ्लूिवयल 

C. पॉइंट बार 3. पौधरोपण 

D. एकॉडेर्ंट सिमट 4. पुनजीर्वन  

 

Options :

1.  A-3, B-2, C-1, D-4

2.  A-4, B-1, C-2, D-3

3.  A-3, B-1, C-2, D-4

4.  A-4, B-2, C-1, D-3

   

Question Number : 74 Question Id : 25498932558 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

How many times has financial emergency been declared in India till August 2021? 

Options :

1.  Once

2.  Four times



3.  Five times

4.  Never

   

Question Number : 74 Question Id : 25498932558 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

अगस्त 2021 तक, भारत में िवत्तीय आपातकाल िकतनी बार घोिषत िकया गया है? 

Options :

1.  एक बार

2.  चार बार

3.  पांच बार

4.  एकबार भी नहीं

   

Question Number : 75 Question Id : 25498935396 Question Type : MCQ Option Shuffling : Yes 

Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

Hydrolysis of cane sugar is called:

Options :

1.  saponification

2.  hydration

3.  inversion

4.  esterification

   

Question Number : 75 Question Id : 25498935396 Question Type : MCQ Option Shuffling : Yes 



Display Question Number : Yes Is Question Mandatory : No Calculator : None Response Time 

: N.A Think Time : N.A Minimum Instruction Time : 0

Correct Marks : 1 Wrong Marks : 0

गन्ने से प्राप्त होने वाली चीनी के जलीय अपघटन को क्या कहा जाता है? 

Options :

1.  साबुनीकरण

2.  जलयोजन

3.  उत्क्रमण

4.  एस्टरीकरण
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Group Id : 2549894529

Group Maximum Duration : 5

Group Minimum Duration : 5
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Group Marks : 0
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Summer camps are supervised camps conducted to entertain as well as equip students with 

various life skills such as teamwork, socializing, decision making, independent and 

responsible living and more. It aids the overall development of a child and children have fun 

during this process as they get to explore new arenas.
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Domestic and international communication has expanded across the globe. This is the 

reason why there is a need for a global language like English which has become the lingua 

franca in major parts of the world. English is one of the most dominating languages in the 

world. It has an impact on every field of work. Although with the positive outcomes the 

negatives outweigh them to some degree as it means that many languages will perish out 

as a result. A global language is one that is spoken and understood at an international level 

by a wide variety of people. A global language is learned by several people as a second 

language. English is known to be the global language in that context. There are arguments 

that languages have a strong link between dominance and cultural power. The main factor 

that the languages exist is because of a powerful power base. The English language itself 

was derived from languages such as German and Latin and other European languages. 

Linguists argue whether the simplicity of the English language is the main reason for it 

becoming a global language. Generally difficulty level varies for everyone and there are 

different factors involved when a person starts learning a language. While learning another 

language one can observe that some languages are more difficult than others. Some 

languages have many similarities in pronunciation and words. For example Greek has 

similarities with Italian. Then there are languages having rough pronunciation or spelling 

and are dissimilar to any other language such as German. English is a very effective 

language and that is proved by the many native and foreign speakers worldwide. Statistics 

show nearly a quarter of the world is already fluent or content in English. Though the 

number of native Mandarin speakers is greater it is still not a global language because of its 

complicated letter system and grammar. Thus for a language to become a global language it 

has little to do with the number of native speakers. English helps to express various 

meanings. It has a lot of words with different meanings and different types of syntax which 

help the speaker to express with great accuracy. Another factor that makes English efficient 

is its compact letter system. It is unlike Mandarin with a ten thousand letter writing system 

which proves to be very difficult for people. Moreover the English language is very phonetic 

rather than character based. Hence it can help to describe the actual sounds of words or 

phrases. A poor feature of the English language is that there could be words with similar 

sounds but with different meaning. This can confuse non native speakers. Another difficulty 



in English is different regions of native English speakers have their accents which makes an 

outsider or a beginner learner of the language to not understand them clearly. Foreign 

speakers also have their specific accents. Since English is so widely spoken in the world 

many have taken up English as their second language. English has allowed a common 

communication means between people of different backgrounds. Hence English has helped 

to diminish certain cultural barriers between nations. However there are still cultural 

differences between countries and nations. In India which has thousands of local languages 

English is used as the official language as a smooth communication mean.
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एक बार की बात है, अकबर और बीरबल िशकार पर जा रहे थे। अभी कुछ समय की उन्हें एक िहरण िदखा। जल्दबाजी में तीर िनकालते 

हुए अकबर अपने हाथ पर घाव लगा बैठा। अब हालात कुछ ऐसे थे की अकबर बहुत ददर् में था और गुस्से में भी।
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लीडरिशप एक अनूठा गुण है जो हर िकसी के पास नहीं हो सकता। यिद आपके पास यह है तो आप खुद को खुशनसीब मान सकते हैं। 

सही िदशा में अपने किरयर को बढाने और अपने आस पास के लोगों को प्रेरणा देने के िलए लीडरिशप के गुण को आगे बढाना जरुरी है। 

हालांिक आगे बढने और अपने कौशल को सुधारने से पहले कई प्रकार के लीडरिशप शैिलयों को समझना जरूरी है। लोकतािंत्रक 

लीडरिशप आपके अधीन काम करने वाले लीडरिशप में िनणर्य लेने की प्रिक्रया का एक भाग हैं। इस तरह का लीडरिशप अधीनों के 

योगदान पर कें िद्रत होता है। हालांिक उनके िनणर्यों और कायर् की अंितम जवाबदेही नेता की है। यह सबसे पसदंीदा लीडरिशप शैिलयों में 

से एक माना जाता है। पिरवतर्नकारी लीडरिशप आपके समूह के सभासदों और संगठन के साथ ही दूसरे कारकों में सुधार करके प्रदशर्न 

को प्रभािवत करने के बारे में है। एक पिरवतर्नकारी नेता शीषर् प्रयोजनों को कायम करके और उवर्रता बढाने के िलए प्रेिषत करके सभी 

को प्रेिरत करता है। एक टीम का नेता अपनी पिरयोजना में पूरी टीम को शािमल करता है। नेता अपनी टीम को कडी मेहनत करने के 

िलए प्रेिरत करता है और साथ ही वह िनधार्िरत प्रयोजनों को हािसल करने और पेशेवर ज्ञान के िवकास के िलए काम करता है। सामिरक 

लीडरिशप इस प्रकार की लीडरिशप शैली में ऐसा नेता होता है जो मूल रूप से एक फमर् या कंपनी का प्रमुख होता है लेिकन वह शीषर् 

प्रबंधन के िवचारों को साझा नहीं करता है। वह पूरी टीम के साथ शािमल होता है। वह नई संभावनाओं और यथाथर्वाद की जरुरत के 

बीच की खाई को जोडने के िलए एक पुल की तरह कायर् करता है। दूरदशीर् लीडरिशप का नेता अपनी टीम के सभासदों की प्रितभा और 

जरूरतों को पहचानता है। वह सफलता की नजर को कायम कर अिभप्रेत पिरणाम हािसल करने के िलए सामूिहक प्रयास करता है 

िजससे सभी सभासद आपस में जुडे रहें। अगर टीम कम काम कर रही है तो एक सुगम नेता अपनी टीम के सभासदों को समय समय पर 

आदेश देकर उनकी काम करने की प्रिक्रया को कुशलतापूवर्क चलाने में मदद करता है। यिद टीम शीषर् कायर्शील से पिरपूणर् है तो नेता 

काम करने के नजिरये को भी अपना सकता है। लीडरिशप की एक शैली में टीम के सभासदों को अिधकार िदए जाते हैं। टीम के सभी 

सभासदों को काम करने की छूट िमली होती है और नेता की ओर से कभी कभार आिंशक दखल अंदाजी होती रहती है। लेन देन संबंधी 

लीडरिशप इस प्रकार की लीडरिशप की प्रिक्रया में लेन देन संबंधी कायर् शािमल है। इस प्रिक्रया के अंतगर्त टीम के सभासदों को सही ढंग 

से नेता के िवचारों और िनणर्य को लागू करने के िलए संमािनत िकया जाता है और इनाम भी िदया जाता है। साथ ही सभी को समय दर 

समय प्रेिरत भी िकया जाता है। सांकेितक लीडरिशप इस प्रकार के लीडरिशप शैली में नेता अपने अनुयािययों के भरोसे के मूल को 

परखने और आचरण को बदलने के िलए समय लेता है तािक अपने कमर्चािरयों से और बेहतर काम करवाया जा सके। अगर आपको 

ऐसा लगता है की लीडरिशप के गुण को अिधक प्रकारों में नहीं बांटा जा सकता तो यहां दी गई जानकारी यह िमथक तोडने में मदद कर 

सकती है। इससे आप अपने अंदर मौजूद लीडरिशप के गुणों और बेजोड लीडरिशप शैली को पहचान कर उन पर महारथ हािसल कर 

सकते हैं।
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